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CHAPTER 1

INTRODUCTION TO FIPPS

1.1 Background

In April 1998, FORWARD determined that it needed to improve its financial
record keeping process. Various spreadsheets had been created to keep track
of different financial and subcontracting information for the project, but the labor
involved in updating the information in each of these spreadsheets began to
surpass their utility. With the initial goal of developing a financial project
management tool that could be used to project future spending, the first draft
version of a simple financial model was created. Following a number of reviews,
it became evident that all activity files could and should be linked and compiled to
provide FORWARD with the necessary information to effectively manage its
finances. A near final version of the program was successfully developed in
August, 1998. This program was dubbed FIPPS and has become an integral
part of FORWARD's operations.

1.2 Capabilities and Limitations

The Financial Invoiced, Pipelined, and Programmable System (FIPPS) was
designed to provide quick reference, budgetary planning, and summary
information in a user friendly format. Whether inputting or referencing data for an
activity, program, or FORWARD in its entirety, FIPPS provides multiple levels of
information. FIPPS also addresses project planning needs by allowing for the
input of various management decisions at any point in the duration of an activity,
quickly updating all data links to other files and workbooks. These interactive

characteristics are the primary strength of the system.

FIPPS is a detailed management program for monthly and long-term project

finance management as well as long-term record keeping. This program deals



strictly with project finance and does not possess additional word processing
capabilities beyond text box data entry.

A glossary of commonly used terms is in Appendix A.

1.3 Modeling Software and System Requirements

FIPPS was developed using Microsoft Excel 7.0 electronic spreadsheet software.
This software allowed each financial component of the activity planning process
to be located on one or more worksheets within the same workbook. Workbooks
were then linked to additionally display summary information by funding type and
by CLIN (Contract Line Item Number).

Programming minimized the memory requirements for a FIPPS workbook. After a
number of modifications, FIPPS requires remarkably little RAM compared to its
early drafts and minimal hard-drive space. The three summary workbooks for
funding and CLIN expense tracking also have smaller memory requirements than
expected, but are significantly larger than the FIPPS activity file and should not
all be opened simultaneously. Opening the four FIPPS workbooks and five to ten
hyperlinks from within a FIPPS file should require no more than a 200 MHz
processor and 8 Mb of available RAM.



CHAPTER 2

FINDING WHAT YOU NEED

FIPPS comprises one primary workbook, the FIPPS activity workbook, and three
summary workbooks. The FIPPS file is subdivided into financial components
assigned to one or more worksheets. Data links exist to transfer data between these
individual components (worksheets) within this primary workbook and externally to
the other three workbooks. All four workbooks are located in the share drive folder
R:/Forward/1fipps.

2.1 Opening a FIPPS File

To open a FIPPS file, using Windows Explorer is recommended. A FIPPS file can

also be opened from within Excel by selecting “Open” from the file menu. Open file
folder Forward on the network drive R:. Individual activity files are then located by
opening either the “Core,” “Egypt,” “Lebanon,” “Jordan,” or “WB/Gaza” file folders.

As programs are developed in other countries, new file folders will be opened.

Within these region files are the individual activity folders, listed by activity number.
For example, one would open R:/Forward/Jordan/518 WAJ IF Cost/Tariff to
access activity 518's FIPPS file. All files for 518 are located in this folder. Inside
each activity file folder is a FIPPS Files folder. Open this folder and double click the
FIPPS activity file. Instructions for reading a FIPPS file are given in Chapter 3.

Figure 2.1: Opening a FIPPS Activity File

GoTo R:\Forward
Then... R:\Forward\Jordan
R:\Forward\Jordan\518 WAJ Cost/Tariff
and Finally R:\Forward\Jordan\518 WAJ Cost/Tarif\FIPPS Files




Figure 2.2: FIPPS Structural Layout

Data entry is done in the files on the left. The data transfers to the files as you move to the right, presenting you with

various levels of reference and summary information.

FIPPS Workbook
(Activity File)

Budget Details
Worksheet

Funding Summary
Workbooks

(with Regional Breakdowns)

Activity Summary

Long-term Details
Worksheet

l Worksheet

* Core Funding Summary
Workbook

Expenditures
Worksheet

Activity Budget
Worksheet

Incremental Funding
Summary Workbook

)

CLIN Funding
Summary Workbook

You can create or modify an “activity file” when using FIPPS. The information you enter in the Budget Details, Long-term Details, and

Expenditures worksheets is first summarized in the Activity Summary and Activity Budget worksheets. FIPPS then transfers this data to the
Core Funding and Incremental Funding workbooks. These workbooks contain one worksheet for each region FORWARD is currently working
in or has completed past work. The data makes one final transfer to the CLIN Summary workbook where each worksheet displays summary and

detailed activity data for each CLIN, one through sixteen. All FIPPS files are located in either their appropriate regional folder or the “1fipps” folder

on the network drive under “R:/Forward.”



CHAPTER 3

FIPPS DESIGN: READING A FIPPS FILE

FIPPS is designed to assist activity planning and tracking. The focus is on the
money. The kinds of questions FIPPS will be able to answer for you include:

How much has been spent?

On whom and for what?

How much is left?

What is a consultant’s airfare? Rates?
What did | include $3,000 for in that activity?
Do | need to amend a contract soon?
Should I increase a line item?

Have we made a budget for activity “###” yet?

3.1 Contents of a FIPPS file

Each FIPPS worksheet contains valuable information to answer these types of
guestions. Each FIPPS file contains six activity specific worksheets, two project
information worksheets and a links worksheet listed below. Each one looks at the
activity from a different perspective, containing and compiling information in

different ways. This chapter discusses the purpose and use of each in detail.

To access these nine worksheets, the FIPPS file has nine tabs placed along the
bottom of the screen with the following labels:

Budget Details
Activity Budget
Long-term Details

Expenditures



Activity Summary
Invoices Pending

Subcon Rates

Int'l & US Per Diem Rates
Links

3.2 Budget Details

You will want to refer to Budget Details to answer questions concerning original
budgeted amounts. This worksheet is identical in format and structure to the
Pipeline Costs and Programmable Funds views of the Expenditures worksheet.
This means this worksheet is used and referenced in the same way, but for
obtaining budgetary as opposed to cost information.

Following is an example of a completed Budget Details worksheet. Notice the
various DAI labor and Subcontractor labor categories. The first page is dedicated
to DAI Labor and includes the following categories:

Expat LTTA (long-term technical assistant)
Local LTTA

Home Office Intermittent

Expat Intermittent

Local Intermittent

Staff

The second page is designed to handle subcontractor costs within three categories:

Subcon HO Staff (home office)
Subcon Consultant

Fixed Price Subcontractor



These categories include the individual or company name, rate, multiplying factors,
burdened rate, total estimated labor cost, and any foreseen per diem, travel, or
other direct costs (ODCs). All of this information will have been entered previously
by the budget creator.

At the bottom of the second page there is an “Additional ODCs” field and a
“Comments” field to the right of it. ODCs listed here could not be attributed to
one individual as easily as they could be to the entire activity. The “Comments”
field should contain the name of the budget creator and any specific comments
on the activity’s budget.

Remember that the information entered in the Budget Details worksheet
automatically transfers to the Activity Budget and Activity Summary worksheets

for easy reference.



Figure 3.1 Sample Budget Details Worksheet

Budget Details 518 WAJ IF Cost/Tariff

Total Funding: (Step 1: enter activity name above)
$ 189,516.99

$ 9,074.87 $ 118,158.70 || $ 25,637.00 $ 12,760.00 | $ 13,581.71 $ 10,304.71
DAI LABOR LOE in hrs Fringe |OH Burdened Rate | Total i Per/ Diem ODCs
Chief of Party $ 40.00 96 32.1% 53% * * $ 80.85 $ 7,761.14 $ 2,200.00 $ 791.00 $ 50.00
Backstopper $ 15.00 40 32.1% 53% $ 3032 $ 1,212.68
Conflict Res Spclst $ 35.00 32.1% 53% $ 7074 % -
Project Assistant $ 10.00 5 321% 53% $ 2021 % 101.06
* Please Note: G&A and Fee for DAI Labor are calculated |s 907487 ]3$ 220000]$ 791.00]$ 50.00
Local LTTA at the top of the page. Not included in Burdened Rate.
$ - 15.7% 42% $ - $ -
15.7% 42% $ - $ -
I's - s - $ - s -
HO Intermittent
53% $ - $ -
53% $ - $ -
53% $ - $ -
s - s IE - s -
Expat Intermittent
$ - 53% $ - $ -
53% $ - $ -
53% $ - $ -
B _1s lE s -
Local Intermittent
$ - 42% $ - $ -
42% $ - $ -
s - s - s - s -
Staff
$ - 53% $ - $ -
53% $ - $ -
53% $ - $ -
B E E ~ 5 -




518 WAJ IF Cost/Tariff
SUBCONTRACTORS (Programmable)

Subcon HO Staff * Rate LOE in hrs  |Fringe |OH |G&A |Fee | Burdened Rate | Total Airfare | Per/ Diem | ODCs
Subcon A $ 30.00 120 15.0% 50% 10.0% 0.0% $ 56.93|$ 6,831.00
$ - $ -
$ 683100 $ - s [ s -
Subcon Consultant
Subcon B/Employee 1| $ 33.49 646 12.0% 50% $ 56.26 | $ 36,346.03|$ 2,200.00 $ 9,124.75 $ 100.00
Subcon B/Employee 2| $ 16.63 720 $ 22.83 | $ 16,439.75
Subcon B/Employee 3| $ 3.43 600 $ 5751 % 3,447.15
Subcon C $ 33.65 240 15.0% 40% 75.0% $ 102.39 | $ 2457446 | % 2,200.00 $ 3,390.00 $ 100.00
Subcon D $ 15.00 360 48% $ 2220|$ 7,992.001% 2,200.00 $ 3,531.25 $ 100.00
$ - $ -
$ - $ -
$ 88,799.39 [ $ 6,600.00 | $16,046.00| $  300.00
FP Subcontractor IRate LOE in hrs  |Fringe |OH |G&A |Fee |Trave| |ODCs
Subcon E $ 16,209.28
Subcon F $ 2,367.47
Subcon G $ 3,951.56
$ 22528.31 | s - |s ]
Additional ODCs
Type Cost
Medical $ - Project Planning Comments:
Visa $ - If multiple tickets for one traveler, please list breakdown here.
Airport Tax $ 240.00 Name From To Price Total
Photocopying $ 1,000.00 Traveler #1 $ -
Communication $ 2,300.00
Car Rental / Gas $ 4,600.00
Local Taxis $ 520.00 Traveler #2 $ -
Business Meetings $ 1,000.00
Computer Rental $ 1,200.00
Supplies $ 750.00 $ -
W orkshops $ 800.00
Training $ -
Total Add. ODCs $ 12,410.00 I * Please Note: Specify G&A and Fee in the appropriate cells for Subcontractors when applicable.




3.3 Activity Budget

For various reasons, this worksheet is more for show than for use. Only two items are
displayed. A simple table presents the budget subtotals and base-line total, and a large
text box recording comments on these budget amounts. For example, if the budgeted
amount needs to be increased, various reasons for doing so could quickly be typed into
the box. A written record then exists to prevent concerns from being overlooked or

forgotten in the future.

Some activities do not have an itemized budget. They are opened in Deltek as a single
figure. In this case, the Activity Budget worksheet is left blank, with the exception of the
baseline total. See Figure 3.2 for a sample Activity Budget worksheet.

Like the Activity Summary Worksheet, there is no reason why any numerical data
should be changed here. Since this sheet is data linked to the Budget Details
worksheet, if an error is noticed, it must be corrected within the Budget Details

worksheet.

3.4 Long-term Details Worksheet

The Long-term Details worksheet should be used to create budgets for activities
involving one or more employees who qualify under the LTTA labor category, especially
if overseas for one year or longer. For example, Wayne Curry’s participation on activity
162 WB/Gaza CAMP LT Support. This worksheet offers an itemized list of all labor, per
diem, travel, and ODCs possible with overhead, fringe, G&A, and fee calculated for you.
Various ODCs that are not included in the short-term projects, such as family visits,

overseas housing, utilities, office rent and supplies, ocean freight, R&R, and so on.

10



Figure 3.2: Sample Activity Budget Worksheet

Activity Budget

518 WAJ IF Cost/Tariff

Positive Budget

Activity Budget

Labor $ 9,074.87
Subcon Labor $ 118,158.70
HO Fringe $ -
HO Overhead $ -
OS Fringe $ -
OS Overhead $ -
Travel $ 25,637.00
ODCs $ 12,760.00
G&A $ 13,581.71
Fee $ 10,304.71
Total

Note: Overhead and Fringe are calculated into the labor and

subcontractor categories, and will not appear as separate totals

Financial Notes: (Please type comments, followed by
date and your initials)

Here are two examples of budget planning notes:

We allotted $4,000 more than we needed for
Subcontractors on this activity. However, we had to
rent two computers and a printer, plus the rental car
was needed for an additional week. These
unforeseen costs are $4050. The extra $50 should
probably come out of HO Labor, so we should
determine who will bill a few less hours to this activity.
-iku, 8/12/98

A computer was returned to us from a recently
completed activity that we will be able to send out on
this activity. That will cut the above mentioned cost
of $4050 by $500, giving a new total of $3550. We
will wait and see for now where we might need to
spend the remaining $450 of the above mentioned
$4000. -iku, 9/4/98

11




The benefits letter for any long-term individual helps outline what additional expenses
will likely be incurred and need to be budgeted for. If there is an item missing from the

list, simply insert a row in the appropriate section and add the item. Inserting the row in

the middle of a section, such as

DO NOT complete both a Budget Details

“Travel,” is recommended to and Long-term Details worksheet for the
guarantee all formulas copy over and same activity. Choose one or the other,
_ " _ . or various formulas will cancel each other
include the additional information in out and the totals in the Activity
subtotal and total calculations. The Summary worksheet will not accurately

. reflect your detailed planning. Further,
number of months performance is within the “DAI Labor” field at the top of

listed in the upper left-hand corner. the Long-term Details worksheet, do not
) shift around the four DAI labor positions
You only need to enter rates and units/ || ith the two LTTA positions. The
LOE in hours on this sheet. formulas calculating overseas vs home
office fringe and overhead are dependent

Everything else will calculate for you. on these labor categories remaining in

See Figure 3.3 on the next page for a

Long-term Details worksheet example.

3.5 Expenditures Worksheet

Ninety percent of the work in FIPPS is done in the Expenditures worksheet. The data
displayed in every summary worksheet of the four workbooks is entered here. The
budget is the only exception, which is entered through the Budget Details or Long-term
Details worksheets. The Expenditures sheet has three horizontal “views” within it:

Costs Invoiced to USAID;

Pipeline Costs; and

Programmable Funds.

12



Figure 3.3: Sample Long-term Details Worksheet

12 Month Budget 162 WB/G CAMP LT Support (1st Year) 15-Apr-98
Description | Rate /Unit | Units (dplh) | Amount
1. Salaries and Wages
Chief of Party () $40.00 | /dplh 248 $9,920.00
Conflict Resolution Specialist () $35.00 | /dplh 384 $13,440.00
Administrative Backstopper () $15.00 | /dplh 96 $1,440.00
DAI () $20.00 | /dplh 45 $900.00
LTTA () $56.92 | /dplh 2080  $118,393.60
TBI () $0.00 [ /dplh $0.00
Total Salaries and Wages $144,093.60
2. Fringe Benefits
a. Overseas 15.70% $118,393.60 $18,587.80
b. Home Office 32.10% $25,700.00 $8,249.70
Total Fringe Benefits $26,837.50
3. Overhead
a. Overseas 42.00% $136,981.40 $57,532.19
b. Home Office 53.00% $33,949.70 $17,993.34
Total Overhead $75,525.53
4. Travel
Airfare: Principal (MT>DC>MT) $1,597.00 1 $1,597.00
Airfare: Principal (MT>CO>MT) $830.00 1 $830.00
Airfare: Principal (MT>Tel Aviv) $1,656.00 1 $1,656.00
Airfare: Principal (Tel Aviv>MT) $1,656.00 1 $1,656.00
Airfare: Family Visit (?>7?) [see Sec. 5.] $2,000.00 3 $6,000.00
Taxi/Baggage (to/from airport) $300.00 2 $600.00
Taxi (local transportation, rt) $1,800.00 1 $1,800.00
Car Rental (per mo.) $2,000.00 12 $24,000.00
Gasoline (per mo.) $250.00 7 $1,750.00
Per Diem - Washington, D.C. (per day) $168.00 4 $672.00
Per Diem - Boulder, CO $130.00 5.5 $715.00
Per Diem - Tel Aviv $220.00 152 $33,440.00
Per Diem - Gaza (TQSA, 30 days max) $0.00
Per Diem - Gaza $0.00
Attendance at regional FORWARD meetings $3,000.00 1 $3,000.00
Total Travel $77,716.00
5. Overseas Allowances
Housing - Tel Aviv (furnished, per month) $0.00 5 $0.00
Housing - Gaza (furnished, per month) $1,000.00 7 $7,000.00
Utilities (per month for the n # of units) $250.00 7 $1,750.00
Settling-In Allowance $6,000.00 1 $6,000.00
Air Freight $3,200.00 1 $3,200.00
Ocean Freight $4,410.00 1 $4,410.00
Storage (6,000 Ibs = 60 CWT @ $3.75/CWT/mo) 0 0 $0.00
Origin (6,000 Ibs = 60 CWT @ $45.00/CWT) $ 45.00 1 120 $5,400.00
Handling (6,000 Ibs = 60 CWT @ $4.75/CWT) $ 4.75 1 120 $570.00
Total Overseas Allowances $28,330.00
6. Equipment
Computer, Printer & cell-phone (incl. VAT @ 17%) $6,900.00 1 $6,900.00
Software (MS Office & Lotus NOTES) (incl. VAT @ 17%) $2,000.00 1 $2,000.00
Total Equipment Costs $8,900.00

13




12 Month Performance 162 WB/G CAMP LT Support (1st Year) 15-Apr-98
Description Rate /Unit I Units (dplh) | Amount
7. Other Direct Costs
Office Supplies (per mo.) $50.00 12 $600.00
Comunications (Office, cell phone, internet)/mo. $500.00 12 $6,000.00
DBA (on base salary) $10,830.00 $10,830.00
FICA (on base salary) $3,165.76 $3,165.76
MEDEX ($119.35/individual/year) $119.35 1 $119.35
MEDEX ($26.10/mo.) $26.10 5 $130.50
Medical Exams (entrance & exit) $150.00 1 $150.00
Total Other Direct Costs $56,895.61
8. Subcontracts
Training (per day) 1000 5 $5,000.00
$0.00
Total Subcontracts $5,000.00
9. Subtotal Costs $396,290.40
10. G&A 8.20% $32,495.81
11. Total Estimated Cost $428,786.21
12. Fixed Fee 5.75% $24,655.21
13. TOTAL BUDGET $453,441.42
14. Special Costs ** (Costs not accounted for above)
Description of Special Cost Rate /Unit Units (dplh) | Amount
Airport Tax $180.00 1 $180.00
CDR Training $1,200.00 1 $1,200.00
Conflict Resolution Specialist - Total Per Diem Estimate] $5,400.00 1 $5,400.00
$0.00
$0.00
Total Special Costs (w/ G&A and Fee added) $7,757.78
15. TOTAL 1st YEAR BUDGET $461,199.19
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There is general congruity in the design of these views to make data entry and reference as
easy as possible. When viewing this worksheet, notice that the header (cell rows 1 through
10) is permanently fixed and the labor categories parallel each other across the Pipeline
Costs and Programmable Funds views. Take a quick look at the Expenditures worksheet,
scrolling across it to the right, to get an idea of what is being described here.

3.5.1 Costs Invoiced to USAID

The invoice view, as the first component of the Expenditures worksheet, is unique with
regard to the information it displays. Notice that the subtotals for each of the ten
budgetary cost types are displayed across the header, as they are for the Pipeline and
Programmable views. However, instead of giving detailed labor information in the

main body, the Invoice worksheet focuses specifically on subcontractor information.

The field titled “Subcontractors on Activity” is where you can find:

the name of the subcontracting company;
amount of the contract;
how much has been invoiced against the contract with current date; and

how much of the contract pertains to the individual activity.

Once the amount invoiced matches or exceeds the amount contracted, the phrase
“Contract Fulfilled for this Activity” appears to the right in blue type. This is the default
phrase and will appear until a contract name and amount (or NEI for Not Enough
Information) have been entered. When the invoiced amount is less than the contracted

amount, it will read “Contract Unfulfilled.”

Directly below the subcontractor field is the “Transfers” field. When expenditures are
transferred into or out of an activity, the amount and the activities involved are entered
here, along with the date of transfer. As noted in the form, if the amount is being

transferred out, it should be expressed as a negative value, and vice-versa for an

15



amount being transferred in. See Figure 3.4 on page 11 for an example of the “Costs
Invoiced to USAID” view from Activity 518.

3.5.2 Pipeline Costs

The second component of the Expenditures worksheet is the Pipeline Costs view.
Pipeline costs are committed funds that DAI has not yet invoiced USAID for. In other
words, the cost should be considered expended, but not invoiced until the invoice has
been sent to USAID for the current month. A Pipeline cost can constitute more than
one month worth of expenditures. For example, the remainder of a fixed price contract
for which an invoice has not been submitted constitutes a pipeline cost. See Figure 3.5
for an example of the Pipeline Costs view.

The Pipeline Costs view is denoted by a black header. In other worksheets and
workbooks, pipeline costs are always under a black label. In terms of format and
structure, the header is identical to the green invoice view, but the remainder of the
worksheet parallels that of the Programmable Funds view.

Labor categories for the pipeline and programmable views are identical to the Budget
Details worksheet. Refer to Section 3.2 of this manual for an outline of these
categories. To reiterate, the “Burdened Rate” for all DAI labor categories is
automatically calculated when a pay rate is entered.

Like the Budget Details worksheet, following the subcontractor fields you will notice a
field titled “Additional ODCs.” Any costs you know will be incurred, but cannot attribute
to an individual should be entered in this field. Copious notes of any changes made to
this view in the “Comments” section must be kept. More so than any other area of

FIPPS, maintaining an accurate record of money flow in and out of the Pipeline Costs

view is critical to effective financial management of the activity.

16



Figure 3.4: Sample “Invoice View” from the Expenditures Worksheet
Acivity No.: 518 WAJ IF Cost/Tariff Costs Invoiced to USAID

Date Started: Core/ IF: IF Amount Invoiced
Current to: 13-Oct-98 Date Completed: 01-Jan-00 $ 119,745.13

Total Labor Total Subcon. HO Fringe HO Overhead OS Fringe OS Overhead | Total Travel Total ODCs G&A
$ 5,200.10 $ 64,685.06 | $ 1,669.23 $ 3,640.75 $ - $ - $ 16,773.80 $ 12,683.71|$ 8,581.52
. Fee
Invoice $ 6,510.96
e e —
Subcontractors on Activity i&mount Invoiced/Last Update IAmount Contracted to Acitivity I
Subcontractor Total contract value
Subcon A $ 6,831.00 01-Oct-98| $ 6,831.00 Contract Fulfilled for this Activity
Subcon B $ 28,937.09 01-Oct-98| $ 46,232.93 -10000]Contract Unfulfilled
Subcon C $ 2,083.59 01-Oct-98| $ 19,574.46 -5000| Contract Unfulfilled
Subcon D $ 4,000.00 01-Oct-98| $ 6,992.00 -1000| Contract Unfulfilled
Subcon E $ 11,209.28 01-Oct-98| $ 11,209.28 -5000| Contract Fulfilled for this Activity
Subcon F $ 1,400.00 01-Oct-98| $ 2,367.47 Contract Unfulfilled
Subcon G $ 2,951.56 01-Oct-98| $ 2,951.56 -1000|Contract Fulfilled for this Activity
Reclassified cost $ 7,272.54 29-May-98| $ 7,272.54 -3000
$ 64,685.06 $ 103,431.24 NEI= not enough information
*o: From: Date:
$ 7,272.54 3144.518 3144.517 29-May-98
$ 7,272.54
* Note: If TRANSFERRING OUT of this activity, be sure to enter the amount
as a negative value, and if TRANSFERRING IN input a positive value.

|Activity Comments .

Subcontractors B,C,D,E,F, and G are accurate and up to date according to all Invoices received that we have record of.
This resolves the discrepancy between the Total Subcon Cost Invoiced to USAID and the actual amount we have been invoiced by subcontractors.

17



Figure 3.5: Sample “Pipeline Costs View” from Expenditures Worksheet

518 WAJ IF Cost/Tariff Pipeline Costs
Amount Committed, Not Yet Invoiced to USAID
$ 30,467.82
Labor Total Subcon. Total Travel Total ODCs Total
$ 1,738.17 $ 17,70353 | $ 5,386.00 $ 1,800.00 | $ 2,183.47 | $ 1,656.64
| Pipeline Sheet |
DAI LABOR Rate LOE in hrs | Fringe |OH G&A [Fee Burdened Rate Total Airfare Per/ Diem ODCs
Expat LTTA
Chief of Party $ 40.00 18 0.321 0.53 $ 80.85 $ 1,455.21
Backstopper $ 15.00 8 0.321 0.53 $ 3032 $ 242.54
Conflict Res Spclst $ 35.00 0.321 0.53 $ 7074 $ -
Project Assistant $ 10.00 2| 0.321 0.53 $ 20.21 $ 40.42
[s 173817[s - s - |s
Local LTTA
0.157 0.42 $ - $
0.157 0.42 $ - $ -
Ls -_[s -_[s -_[s
HO Intermittent
0.53 $ - $
0.53 $ - $
Ls [s [s [s
Expat Intermittent
0.53 $ - $
0.53 $ - $
Ls [s [s [s
Local Intermittent
0.42 $ - $
0.42 $ - $
Ls E E E
Staff
0.53 $ - $
0.53 $ - $
[s [s [s [s
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If you or someone else have not gotten around to making intended changes, an initialed
note should be included in the “To Do List” field to the right of the “Comments” field.

3.5.3 Programmable Funds

The Programmable Funds view is identical in structure to the Pipeline Costs section.
The difference is in purpose. The programmable section contains all the labor
information entered in the Budget Details worksheet, except LOE in hours. The
Programmable view is used to “program” funds that have not yet been invoiced or
pipelined. Programming is the act of working out different options to gauge their cost.

For example, if there is one position still open for a subcontractor, and you have four
potential applicants, you would want to know the impact of each on your budget. To
determine this, their labor information is entered in the same way as the Pipeline Costs
view and Budget Details worksheet. See Figure 3.6 on page 14 for an example of the
“Programmable Funds” view. Since the second page of the Programmable Funds and
Pipeline Costs views are identical in form to the Budget Details worksheet, they have

been omitted to avoid repetition.

If you are making budget modifications, the Programmable Funds worksheet can be
used to accomplish this task as well. In the top left corner, two subtotals are calculated:

“Amount Programmed”: which totals all data entered in just the Programmable
Funds view; and
“Amount Available for Programming”: which identifies the remaining budgeted

amount after taking the “Amount Programmed” into account.
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Figure 3.6: Sample “Programmable Funds View” from Expenditures Worksheet

Amount Programmed

Amount Available for Programming

$ 33,137.96
$ 6,166.08
Labor Total

$ 2,142.40

Programmable Funds
Total Funding $ 189,516.99

Subcon. Total

Travel Total
$ 21,041.71 | $

ODCs Total

518 WAJ IF Cost/Tariff

G&A

Fee

3,477.20 $ 2,300.00 | $2,374.83 | $ 1,801.83

Programmable Sheet

DAI LABOR Rate LOE in hrs| FringgfOH |G&A |Fee | Burdened Ratd Total Airfare Per/ Diem | ODCs
Expat LTTA
Chief of Party $ 40.00 22 0.321] 0.53 $ 8085 $ 1,77859 $ 2,200.00 $ 791.00 $ 50.00
Backstopper $ 15.00 101 0.321] 0.53 $ 3032 $ 303.17
Conflict Res Spclst | $  35.00 0.321| 0.53 $ 7074 $
Project Assistant $ 10.00 3| 0.321] 0.53 $ 2021 $ 60.63
[s 214240 [$ 2200.00|$ 791.00]$  50.00
Local LTTA
0.157| 0.42 $ $
0.157| 0.42 $ $
E [s [s [s
HO Intermittent
0.53 $ $
0.53 $ $
E [s [s [s
Expat Intermittent
0.53 $ $
0.53 $ $
E [s [s [s
Local Intermittent
0.42 $ $
0.42 $ $
E [s [s [s
Staff
0.53 $ $
0.53 $ $
B B [s B
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As you may have inferred, the “programmable amount” is calculated by subtracting the
sum of invoiced, pipelined and programmed funds from the budgeted amount:

Programmable Funds = Budget - (Invoiced + Pipelined + Programmed)

The data entered into the Programmable Funds view is thus considered “programmed,”

while the remaining amount is always referred to as the amount still “programmable.”

3.6 Activity Summary

Contained within the FIPPS activity workbook, the Activity Summary worksheet
displays an activity’s financial information on one page. The table presented at the top
of the worksheet contains five vertical columns for:

Activity budget subtotals;
Costs invoiced to USAID;
Pipeline costs;
Programmed funds; and

Funds still available for programming.

There is no need to make changes to the Activity Summary worksheet because the
data presented on this worksheet was entered in the Budget Details and
Expenditures worksheets. If an error is found, one must return to the Budget Details

and Expenditures sheet and find where the data entry error was made.

There are twelve standard budgetary and cost items presented horizontally in this table.

They cross with the cost types listed above for easy reference. Note that negative
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values appear parenthetically in red type. They are:

DAI Labor
Subcontractor Labor
Home Office Fringe
Home Office Overhead
Overseas Fringe
Overseas Overhead
Subcontractor Fringe
Subcontractor Overhead
Travel and Per Diem
ODCs

G&A

Fee

Figure 3.7: Sample Activity Summary Worksheet

Activity Summary

518 WAJ IF Cost/Tariff

Positive budget
Cost Categories  [=1¥ls[o[: oice Pipeline Progra <ol Programmable
DAI Labor $ 9,07487 | $ 5,200.10 | $ 1,738.17|$ 2,142.40
Subcon Labor $ 118,158.70|$ 64,685.06|$ 17,703.53 | $ 21,041.71
HO Fringe $ - $ 1,669.23
HO Overhead $ - $ 3,640.75
OS Fringe $ - $ -
OS Overhead $ - $ -
Travel/ Per Diem | $ 25,637.00|$ 16,773.80|$ 5,386.00|$ 3,477.20
ODCs $ 12,760.00($% 12,683.71|% 1,800.00|9% 2,300.00
G&A $ 13581711 % 858152 |% 2,18347|% 2,374.83
Fee $ 10,304.71 | $ 6,51096|$ 1,65664|% 1,801.83
Total 189,516.99 119,745.13 30,467.81 33,137.97 & 6,166.08

This is the top half of the Activity Summary worksheet. Just below the activity name, the worksheet
notifies you when activity is over budget or has a positive budget. The budget and all cost subtotals are
broken down into standard cost types for easy reference.
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Figure 3.8: The Lower Half of the Activity Summary Worksheet

Invoiced and Pipelined $ 150,212.94
Invoiced + Pipelined + Programmed $ 183,350.91
Programmable $ 6,166.08
Remaining 3.254%
Total Programmed $ 33,137.97
Total Still to Program $ 6,166.08

Distribution of Funds

3.3%

17.5%

16.1%
63.2%

Invoiced

Pipelined
Programmed

il

Still to Program

Perhaps the most important pieces of information here are the “Total Still to Program”
and the percent remaining. Remaining funds have not yet been committed in any way;
meaning, they have not been invoiced, pipelined, or programmed. If a cost has been
invoiced, the funds have already been dispersed. Pipeline costs are those you know
must be paid, but have not yet been invoiced to USAID. A typical pipeline cost is the
total amount of a fixed price contract that is yet to be paid. Likewise, an expected
invoice for which you have an idea of how many hours LOE it involves, may be included
in the “Pipeline Costs” section of the Expenditures worksheet.

Programmable funds are more flexible. To “program” funds, simply designate them for
certain purposes. In a sense, programming is forecasting future expenses for an
activity. Itis important to program funds to make sure those foreseen expenses are
accounted for when making decisions. To calculate the per cent remaining, divide the

programmable funds by the budgeted amount and multiply by 100.
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3.7 Invoices Pending

Any invoices received by FORWARD that have not yet been submitted to USAID are
entered in the Invoices Pending worksheet. This includes travel vouchers and
subcontract invoices. Even though it is similar in purpose to the Pipeline Costs view of
the Expenditures worksheet, it details only the current pending costs, whereas the
pipeline section considers all obligated costs not yet invoiced to USAID. Occasionally, it
is critical to record these week to week expenditures on an activity to stay within budget
and make budgetary decisions affecting other activities.

As information is added to this sheet, the total boxes to the right will recalculate the
current invoiced amount for the activity. Around the middle of each month, with the
release of the most recent invoice to USAID, this worksheet should be purged and a
new month of record keeping should begin. See Figure 3.9 for an Invoices Pending

worksheet example.

3.8 Subcontractor Rates

When entering labor information, it is important to remember the current rates for an
individual or subcontractor. Click on the tab labeled “Subcon Rates” to view this
worksheet. The worksheet contains the individual or company’s name, their most
recent hourly or daily rate of pay, and either their multiplying factors (fringe, overhead,
G&A, fee) or their total multiplier.

This worksheet will actually be one combined data link to a separate spreadsheet
maintained in the R:/FORWARD/1fipps file folder under the title “Subcon Rates.” Each
time a FIPPS Activity Workbook is opened, you will be asked whether you would like all
links updated. This worksheet is one of the links that will update for them in
approximately 15 seconds. Please see a FIPPS Activity Workbook for an example of
this worksheet.
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Figure 3.9: Sample Invoices Pending Worksheet

For the Month of:

August

1998

Current Invoices and Travel Vouchers

This sheet contains Invoice and Travel Voucher amounts not yet processed by USAID

Invoices
Date Invoice
Subontractor Submitted Total
Subcon B 8/10/98| $9,680.00
Subcon C 8/21/98| $4,065.00
Subcon D 8/21/98| $2,992.00
Subcon F 8/23/98 $966.53
Total Invoiced Amount $17,703.53
Travel Vouchers
Travel ODCs

Name Date Total Total
Subcon A 08/08/98| $3,186.00 | $1,550.00
Peter Reiss $2,200.00 $250.00
Total Travel Voucher $5,386.00 | $1,800.00

Current
Invoice
Total

$173,240.03 |

Equals amount invoiced to USAID
plus all costs listed on this sheet.

Past
Subcontractor
Total

To Date
Subcontractor
Total

$ 107,947.98

$ 107,947.98

Note the differences between Past and To Date
Costs for these cost categories (above/below)

— 5

Past To Date
ODC Total ODC Total
$ 12,683.71|% 14,483.71

Past To Date
Travel Total Travel Total
$ 16,773.80| % 22,159.80
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3.9 International and U.S. Per Diem Rates Worksheet

When planning travel for one or more people on an activity, having current per diem
rates at your fingertips is essential. To reference this worksheet, click on the label “Int’l
& US Per Diem.” This is quicker than having to logon to the State Department or
Policyworks websites. However, if you want to double check any rate, click on the
“Links” tab and then click on the hyperlink for the State Department per diem website

(http://www.state.gov/www/perdiems/9812perdiems.html).

This worksheet will be maintained in a similar fashion to the Subcontractor Rates
worksheet, by creating data links to a template in the R:/FORWARD/1fipps file folder
under the title “Per Diem Rates.” When an existing FIPPS Activity Workbook is opened,
this worksheet will also update if you so choose.

3.10 Links Worksheet

Depending on the activity at issue, creating or modifying a budget, or making changes
to the Expenditures worksheet can require one to access a large amount of information
contained in summary and activity-specific documents peppered throughout the
R:/Forward file folder.

To avoid having to painstakingly open a number of applications one at a time, trying to
manage them on your desktop, simply refer to the Links worksheet and double click on
the link to the document of your choice. This should save the you a significant amount
of time, and all documents that are opened via a link can still be edited and saved. The
Links page thereby expands the activity planning and project management possibilities.
For example, if in making an activity budget it is realized that an individual’s scope of
work can be expanded because more funds are available than previously thought, you
can go to that SOW via a link and make additions.
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The first half of the Links worksheet presents categories containing various financial
and summary documents, as well as links to relevant internet sites. The lower half of
the document contains links to all other FIPPS activity workbooks listed by activity

number. Links to activity specific documents can then be found beneath their activity

number.

Like the Subcontractor Rates and Per Diem Rates worksheets, all links are
maintained via data-links from a template in the R:/Forward/1fipps file folder. This
worksheet will then be updated each time an existing FIPPS Activity Workbook is

opened.
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CHAPTER 4

CREATING A FIPPS FILE

Now that you have read how to reference a FIPPS file, it should be relatively easy to
create one. You are familiar with the general format of every FIPPS worksheet and the

general purpose each of them serves.

However, to create a FIPPS file, the worksheets must now be used in the correct order

and data properly entered. This section will focus on:

The proper order for creating a FIPPS file;
Specific details concerning which cells can receive information and which cannot;
and

Where the information goes once it has been entered.

4.1 Opening FIPPS

Before you can take the first step in creating a FIPPS file, you must open a copy of the
FIPPS Template. Select New from the File menu, and click on the tab titled
Spreadsheet Solutions. This tab includes various templates depending on how Excel
has been installed on your computer. Double click the one titled FIPPS Activity
Workbook and FIPPS will open for you. Once FIPPS has been installed on your
computer, you will also find under the Spreadsheet Solutions tab shortcuts to the other
three FIPPS workbooks.

Notice that there are nine tabs across the bottom of your new FIPPS Activity
Workbook. These are the nine worksheets reviewed in the previous chapter, “Reading
a FIPPS File.” You are now ready to begin customizing the template for your own

activity.
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4.2 Where to Start

Begin with the Budget Details worksheet by clicking once on the tab labeled “Budget
Details” found along the bottom of your screen. Remember that the arrows in the lower
left hand corner of the screen are used to scroll right and left through these tabs. If you
are not at the top of the worksheet, use your mouse or arrow keys to move to the top.
As a shortcut, move directly to the top by simultaneously pressing Control+up arrow.

You want to enter the following information in the Budget Details worksheet:

In row 1, enter your new activity number and name to the right of the phrase “Budget
Details.” The activity number and name will automatically copy to every other
worksheet page in the FIPPS activity workbook.

To enter detailed information, simply scroll down the form and input data, such as
rate and LOE, where necessary. For a definition of labor categories contained in
this sheet, please see Appendix A. If you do not want to enter detailed budget
information, refer to the top of column one, and enter your baseline amount under
“Total Funding.”

If you have chosen to enter detailed information, follow this step. You must
determine what positions to create to complete the goals outlined for your activity.
Enter either the position title or the name of the person who will be fulfilling this role
in the appropriate labor field of the first column. An example of Expat LTTA would
be the Chief of Party or the Backstopper for your activity. Since FIPPS is only used
for FORWARD, the names and rates of all project employees are already entered for
you.

Enter the individual’'s rate and LOE in hours in the two columns to the right. If you
are entering Subcontractor information, any fringe, overhead, G&A, and/or fee will
also need to be included as a percentage rate. FIPPS then calculates the

“Burdened Rate” and “Total Labor” cost for the individual.
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If the person will be flying, requiring per diem allowance, or expected to incur any
other expenses, enter these estimated costs in the three columns to the right of the
individual’s total labor cost.

Entering subcontractor information on the second page of the Budget Details sheet is
the same as above, except for the multiplier. You can enter the multiplying factors
(fringe, overhead, G&A, fee) in one of two ways:

If you have the individual fringe, overhead, fee and sometimes G&A rates unique to
the subcontractor, simply enter them in the corresponding columns to the right of the
individual’'s name, rate, and LOE in hours. For example, if subcontractor A has
fringe and overhead rates of 18.27% and 110% respectively, enter “18.27” in the
“Fringe” column and “110” in the “OH” column. Likewise for G&A and fee; or

If you already have a multiplier, you must go directly to the “Burdened Rate” column

and enter the following formula:

=multiplier*Rate

For example, if Subcontractor A’s multiplier is 2.775, enter the following:

=2.775*(cell address containing rate) or, for this particular example, =2.775*B48.

“B48” would here be the cell address of the rate for Subcontractor A. When entering a
formula, you can always type the column letter followed by the row number for the cell
holding the information you need—

known as the “cell address.” If you are unsure what these rates are, click
on the tab labeled “Subcon Rates.” If you
cannot find the name of the individual or
The additional ODCs field at the company here, reference the Best and Final,
located on the bookshelf in Peter Reiss’
office. If neither of these contain the

used for any general expenses that multiplier information you need, see the
hanging file for the individual or company.

bottom of the worksheet can be

you did not wish to attribute to one
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individual, but to the activity as a whole. If the charge you have in mind is not included
in this list, simply overwrite a charge type that you will not be using.

A “comments” field is located to the right of the Additional ODCs field. Enter any
suggestions or ideas here that you may not remember in the future when you will need
them. If you find yourself entering a lot of notes here, open a Microsoft Word document
and make a list of items that you can refer back to later.

Then, create a link within the “comments” field to that As a general rule, do not
. . . . . enter data into a cell
document by following the instructions in section 8.4 of titled “Total.”

this manual.

4.3 Expenditures

Once you have created the new activity budget, go to the Expenditures worksheet and
enter the necessary information there. This includes the start date of the activity, what
date the information is current to, and whether or not the funding for this activity is from

core or incremental funds.

The subcontractor names you entered in the budget details worksheet will have

automatically transferred to your Expenditures worksheet. If multiple employees will be
working on the activity from a single subcontractor, it is recommended that each name
or position title of these individuals be entered in the Budget Details worksheet. From

there, the names will transfer to the Pipeline Costs and Programmable Funds views.

You only need to enter the detailed subcontractor information just below the green
header of the Invoice view, in the “Subcontractors on this Activity” field. To the right of
the Subcontractor name, enter the amount that has been invoiced by that subcontractor
and the date this amount was invoiced. In the next column to the right, enter the total
amount contracted with each subcontractor to this activity. If there is no way to
determine a contracted amount for a specific activity, then type “NEI” for “not enough

information.” Once the invoiced amount matches or exceeds the contracted amount,
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“Contract Fulfilled for This Activity” will appear further to the right in blue type. This
means no further invoices against this activity can be expected from that individual

subcontractor without exceeding the contracted amount.

If any costs have been transferred from an existing activity into your new one, enter the
amount as a positive value in the “Transfers” field of the Invoice view. Finally, if you
have any additional comments regarding the three different aspects of the
Expenditures worksheet, write them in the “Comments” field for each view that you

have them for.

You will continually return to the Expenditures worksheet for two reasons:

To retrieve information you know is entered there; and

Enter new information/ costs for the activity.
Nearly all of your interaction with FIPPS will occur in the Expenditures worksheet.
4.4 Stop Right There!
You do not need to enter data anywhere else in the FIPPS activity file. All the
information you entered in either the Budget Details or Long-term Details and
Expenditures worksheet automatically transfer either directly or through various

calculations to the other file worksheets. In the future, simply click on the Activity

Summary worksheet for quick reference to previously entered information.
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CHAPTER 5

SUMMARY FILES

There are three summary workbooks that can be opened from the 1fipps folder in the
Forward folder on the network drive, or just click on the appropriate hyperlink on the
links worksheet in your FIPPS Workbook. They are titled:

Incremental Funding Project Summary
Core Funding Project Summary
CLIN Summaries 1-16

Each of these workbooks contains a “Wrap-up” worksheet, followed by a worksheet for
each region or CLIN, depending upon which workbook you are in. To access a regional
or CLIN worksheet, click on the corresponding tab at the bottom of the workbook.

5.1 Linking New Activity Workbooks to Existing Summary Workbooks

When a FIPPS Workbook is created for a new activity, the addition must also be made
in the summary workbooks. FIPPS does not automatically create a row in each of these
workbooks with each new activity workbook. This is a shortcoming of the program, but

is relatively easy to learn to overcome.

Here is how you do it:

Click on the “Wrap-up” tab and scroll down through the activity numbers until you find
where the new activity should go. Highlight the row containing the activity number that
should follow your new activity number. For example, if you are creating activity
number 517, where 518 already exists, highlight the row containing activity number 518.

Choose Row from the Insert menu. All formulas will properly replicate in your new row.
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5.2 Establishing Data-links

From here, you will need to go through a short process to establish data links between
the “wrap-up” sheet and your new activity file. To complete the following process, both

the summary and new activity workbooks must be open.

First, in the “wrap-up” worksheet, type your new activity number in the far left column of
the new row you just inserted. Move one column to the right, to the “Budget” column
(colored red), and type an “=" sign. Now click on the new activity workbook, and click
again on the Activity Summary worksheet tab. It is important that the next action you
make is to click on the red “Budget” total within this activity worksheet. Type Return
and the data link has been established. The process is simple, but at the same time it is

critical that no mistakes are made or else inaccurate data will be transferred.

Notice that the budget amount in your new Activity Summary “budget” column now
appears in the corresponding cell of the “Wrap-up” worksheet of the summary
workbook. Repeat this process again for the Pipeline, Programmable, Amount
Remaining and Percent Remaining columns, as necessary. From this point on, these
two corresponding cells in two different workbooks will be data linked and always

contain the same dollar amounts.

To finish the data-linking process, you must repeat the process you just completed in
the “Wrap-up” worksheet in the appropriate regional worksheets. The regional tabs in
the core and incremental funding summary workbooks look exactly like the Activity
Summary worksheet from the FIPPS Workbook, and calculate information using the
same formulas. You will notice that in these regional worksheets, the “% remaining”
column is instead a row figure found directly below the summary table. You do not
need to establish a data link between regional worksheets and the “% remaining” cell in
the Activity Summary worksheet. You will probably need to practice this process a
few times to get the hang of it, but once you have, many aspects of FIPPS and Excel

will become easier to use.
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Figure 5.1: Creating a Data-link between Summary and Activity Files

Project Summary for Core Funding

Wrap Up [Core

101
111
121
122
123
125
126
151
152
164
165
166
211
251
322
324
351
451
453
511
512
513
514
515
517
518
519
526
751
TBA

Totals

Positive budget

Activity # JEI0e[e[=8

Invoice

% = less than 25% remaining

Pipeline

Ml cIninl=l/lll Programmable

% Remaining

$ 68,500.00 | $ 63,592.01 | $ - $ - $ 4,907.99 7.165%
$ 91,213.05| $ 133,216.33 | $ - $ - $ (42,003.28) -46.050%
$ 2489895|$% 34967.99 | $ - |s - |'$ (10,069.04) -40.440%
$ 31,609.08 | $ 28,001.58 | $ - $ - $ 3,607.50 11.413%
$ 138,392.00 | $ 167,057.30 | $ - $ - $ (28,665.30) -20.713%
$ 50,000.00 | $ - $ - $ - $ 50,000.00 100.000%
$ 200,000.00 | $ - $ - $ - $ 200,000.00 100.000%
$ 58,577.57 | $ 4,607.67 | $ - $ - $ 53,969.90 92.134%
$ 16,262.00 | $ 13,33441 | $ - $ - $ 2,927.59 18.003%
$ 10,000.00 | $ - $ - $ - $ 10,000.00 100.000%
$ 25,337.08 | $ - $ - $ - $ 25,337.08 100.000%
$ 59,971.01 | $ - $ - $ - $ 59,971.01 100.000%
$ 58,381.44 | $ 27,282.11 | $ - $ - $ 31,099.33 53.269%
$ 19,759.69 | $ 6,777.37 | $ - $ - $ 12,982.32 65.701%
$ 61,010.00 | $ 23,513.25 ( $ - $ - $ 37,496.75 61.460%
$ 20,000.00 | $ - $ - $ - $ 20,000.00 100.000%
$ 455841 1% 1,616.11 | $ - $ - $ 2,942.30 64.547%
$ 19,937.25|$  46,764.28 | $ - |s - |'$ (26,827.03)| -134.557%
$ 20,000.00 | $ - $ - $ - $ 20,000.00 100.000%
$ 30197263 |$ 170,585.60 | $ - $ - $ 131,387.03 43.510%
$ 3849400 |$ 68714.07 | $ - |3 - | $ (30,220.07) -78.506%
$ 5659476|$%$ 87,651.26 3% - |s - |'$ (31,056.50) -54.875%
$ 6070056 | $ 61,523.39 | $ - |3 - |3 (822.83) -1.356%
$ 39,174.81 | $ 25,607.21 | $ - $ - $ 13,567.60 34.633%
$ 3399000|$ 34151.08|$ - |8 - |3 (161.08) -0.474%
='\DAIDB\COMMON\FORWARD\CORE\Jordan\518 Jordan FIPPS Files\[1.518 WAJ]Activity Summary'!$B$18

$ 35,000.00 | $ 48,556.42 | $ - $ - $ (13,556.42) -38.733%
$ 33,100.00 | $ 57,756.78 | $ - $ - $ (24,656.78) -74.492%
$ 25,000.00 | $ - $ - $ - $ 25,000.00 100.000%

#DIV/0!

$ 1,602,434.30 $ 1,105,276.24 $ 497,158.06 31.03%

A new activity, number 518, is being data-linked into this worksheet, titled “Core Wrap-

up,” of the Core Funding Summary Workbook. Note the equals sign entered in the cell

beside the new activity number. The next step, to click on the corresponding cell in the

Activity Summary worksheet of your new FIPPS activity file, has been done and the cell

address is displayed. When you hit return, this cell address will disappear, and the

budget total for Activity 518 will appear in its place.
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CHAPTER 6

LINKS TO FILES AND THE INTERNET

If you are reading this manual on-line, click on the hyperlink below to see how the

FIPPS links page can take you to any file or website listed in seconds.

http://www.cnn.com/WORLD/meast/

6.1 Accessing Share Drive Files

Links have been established for easy reference to information not traditionally
maintained within one of the four FIPPS workbooks. These would include all text
documents created in Microsoft Word and any related spreadsheets created using

Microsoft Excel.

All files are broken down into the following categories on the links page:

FIPPS User Manual

Financial Summary Files and Workbooks
Forms

Contacts

Documents

Lists & Gen Information

Per Diem Rates

FIPPS Activity Files

The FIPPS Activity Files category further divides activity numbers by their type of
funding. Firstis core funded activities followed by the incrementally funded.
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6.2 Connecting to the World Wide Web

Two of the above mentioned categories contain links to internet websites. The “Lists &
General Information” category connects you with a currency converter for all world
currencies and the CNN Middle East news section of the CNN website. The “Per Diem
Rates” category contains a link to the State Department web site for international per

diem and to the Policyworks web site for domestic per diem rates.

Links may be added in the future if necessary and will automatically appear in all FIPPS
activity files through a data-linking process to a links template.
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CHAPTER 7

MAINTENANCE

Maintenance requirements for the FIPPS system will diminish with time. The template
for all FIPPS workbooks has been designed so that non-activity-specific information
does not have to be entered directly into the template, but is instead linked in. Each
time information needs to be updated for accurate project planning reference, it is done
in a small handful of documents external to the four FIPPS workbooks. This requires
the alteration of only one external form to execute a desired change, as opposed to
meticulously reviewing each FIPPS Activity Workbook and manually updating the

information inside.

These documents are located on the share drive at R:/Forward/1fipps/Forms &
Templates. Their titles cannot be changed, or the links to the FIPPS format will be
rendered illegible to Excel. For this reason, these documents will be protected, using
the password: forward. If for any reason you need to make changes to one of these
documents, select Protection from the Tools menu, and click on Unprotect Sheet.
Enter the password “forward.” This will enable you to make changes in the document.
No worksheet should be protected and the protection mechanism should not be
reactivated once disabled.

A bi-monthly review of the state of FIPPS is recommended to tackle any major errors in

format or function and make additions or subtractions to the program structure.
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CHAPTER 8

COMMON QUESTIONS

How do | create a new FIPPS worksheet?

Open Microsoft Excel. Choose New from the File menu. Then click on the
Spreadsheet Solutions tab and select the FIPPS Activity Workbook icon. A new
FIPPS activity file will open for you. Head straight to the Budget Details worksheet by
clicking on the tab titled “Budget Details” found along the bottom of your FIPPS

workbook.

What do | do if | accidentally erase a formula from a cell in the

“Expenditures Worksheet” or from anywhere else?

First, choose the Undo option from the Edit menu. If you have entered too many
commands since making the initial mistake, undoing everything may be more of a
burden than it is worth. There are two options for correcting your mistake:

Reference a cell within the Expenditures Worksheet that runs the same calculation
as the one you have accidentally omitted and copy the needed formula from it using
the basic copy and paste functions; or

Go to the “Index of Mathematical Equations” chapter, following the glossary in this

user’s manual and copy the equation from there.

To execute the first choice, find the formula and duplicate it by choosing the Copy
function from the Edit menu. Beware that when you paste the formula, you must
choose Paste Special from the Edit menu and select Formula Only. If you do not, the

computer will transfer the number from the other cell to the one you are correcting.
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How do | know what costs have and have not been invoiced?

Go to the Expenditures Worksheet. Reference the “Current to” field on line 4 in the

green header section at the top of the page. You will see the date of the most recent
cost(s) invoiced. If you are concerned with recent subcontractor invoices, scan down
the page to line 12. This is the “Subcontractors on this activity” field, and contains the

date of the most recently processed invoice from each subcontractor.

You must then have the date the invoice in question was processed by finance if you
are to determine whether it has been invoiced to USAID. It is preferable to track costs
by date instead of amount because a subcontractor will sometimes invoice for an

identical amount in two subsequent invoices.

How do | create a link to another file or website?

Open the document you want to create the link from. If in Microsoft Excel, put the
cursor in the cell you would like to place the link in. In Microsoft Word, move the cursor
to the desired place in your text document. Then choose Hyperlink from the Insert
menu. Click on Browse and select the document you would like to link to your current
worksheet or page. The link will then appear for you. Click your new link to make sure

it works.

What if | receive a dialog box that says the worksheet is protected and | cannot

enter data or make changes to the form?

First check to be sure you are on the correct page to make your changes to FIPPS.
Remember, all the information displayed in the file was entered in only one of three
places: the Expenditures, Budget Details, or Long-term Details worksheets. You
should be able to go to these worksheets and make the changes there.

However, if you still need access to a page asking for a password, type the word
“forward” in lower case letters and click OK.
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Activity Summary

Activity Budget

Budget Details

Burdened Rate

Core funding

Expat intermittent

Expat LTTA

Expenditures

FIPPS

FIPPS file template

FORWARD

APPENDIX A

GLOSSARY

Reference worksheet in the FIPPS activity workbook that
provides summary information for one activity

Rererence worksheet for budget subtotals in the FIPPS
activity workbook. Contains a comments section where
possible budget modifications should be outlined and
initialed by you

Worksheet in FIPPS workbook used to do budget planning
for an activity. Completing this worksheet is the first step in
creating a new FIPPS file

The total labor cost to USAID, equal to the individual’'s pay
times applicable fringe, overhead, G&A, and fee rates

One of two funding types used to finance FORWARD. ltis
funds provided by the ANE Bureau, largely for proper
management and program design. For a summary of
FORWARD'’s core funding, go to the Core Funding Project
Summary workbook found in the folder
R:/Forward/1fipps/Core Funding Summary

A short-term overseas DAI Labor category defined as
receiving no fringe and 53.0% overhead.

A long-term DAI Labor category, defined as receiving 32.1%
fringe and 53.0% overhead

An extensive worksheet at the heart of the FIPPS workbook.
Input all invoice, pipeline and programming information in
this worksheet

Financial Invoice, Pipeline, and Programming System

Is the workbook used to create a FIPPS file for an individual
activity. Referred to as the “FIPPS activity workbook” or
“FIPPS file.” A blank copy can be opened in Excel from the
New menu by clicking on the Spreadsheet Solutions tab
and selecting the FIPPS Activity Workbook

Fostering Resolution of Water Resource Disputes
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HO intermittent

Incremental funding

Invoice

Links

Local intermittent

Local LTTA

LOE

Long-term Details

Per Diem sheet

Pipeline

Program

Programming

Home Office intermittent. Short-term DAI Labor, defined as
receiving no fringe and 53.0% overhead

One of two funding types used to finance FORWARD. ltis
usually provided by a USAID mission for a specific
assignment. For a summary of FORWARD's incremental
funding, go to the Incremental Funding Project Summary
workbook found in the folder
R:/Forward/1fipps/Incremental Funding

Costs invoiced to USAID on a monthly basis. FIPPS reflects
these invoiced costs in the Expenditures Worksheet

The “Links” worksheet in the FIPPS file workbook provides
hyperlinks to various files on DAI's network R: drive,
websites containing pertinent information such as per diem
rates, and all FIPPS files

Short-term overseas DAI Labor, defined as receiving no
fringe and 42.0% overhead

Long-term overseas DAI Labor category, defined as
receiving 15.7% fringe and 42.0% overhead

Level of Effort. Throughout FIPPS LOE is expressed in hour
units, which is consistent with the FORWARD contract

Budget planning worksheet designed for one 12-month
increment to be used when employing one or more long-
term overseas team members

The current per diem rates for all nations FORWARD is
currently active in can be referenced through either the
“International and U.S. Per Diem Rates” worksheet or the
“Links” worksheet within the FIPPS activity workbook

Pipeline costs are costs that are committed but not yet
invoiced to USAID

“Program” is the noun definition given to each subsection of
FORWARD. For example, “The Egypt Program,” which is
usually incrementally funded

Using funds remaining for a specific activity, Programming is

the act of financially working out different options to gauge
their cost
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Programmable funds

Programmed

Relative Cell Reference

Workbook (or file)

Worksheet

Funds that are not committed through invoice or pipeline
costs are yet to be programmed. Labeled, “Total Still to
Program” in the Activity Worksheet of the FIPPS Workbook

Funds that have been designated by someone through the
“programming process.” See 3.5.3 Programmable Funds

A reference identifies a cell or a range of cells on a
worksheet and tells Microsoft Excel where to look for the
values or data you want to use in a formula

In Microsoft Excel, a workbook is the file in which you work
and store your data. Because each workbook can contain
many sheets, you can organize various kinds of related
information in a single file. The four workbooks associated
with the FIPPS system are: FIPPS File Template; CLIN 1-16
Summary; Core and Incremental Project Funding
Summaries

The primary document you use in Microsoft Excel to store

and work with data. A worksheet consists of cells organized
into columns and rows and is always part of a workbook
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APPENDIX B

INDEX OF MATHEMATICAL FORMULAS USED IN FIPPS

Percent Remaining

% Remaining = Budget — (Invoiced + Pipelined + Programmed)

This formula is used in the Activity Summary Worksheet and Core and Incremental
Funding Summary Workbooks. The cell references for this equation vary by worksheet,
depending on the amount of information contained in each form.

Burdened Rate for Subcontractor

Burdened Rate = pay rate * specific fringe, OH, G&A and/or fee

This formula is used in the Pipeline Costs and Programmable Funds views of the
Expenditures Worksheet and in the Budget Details Worksheet. Example for
Pipeline Costs view (this formula can be copied directly into the Burdened rate column
of the Pipeline Costs view):

=(((LA4*O44+LA4)*PA4+(LA4*O44+L44))*QA4+((LA4*O44+LA4)PA44+(LA4* 044
+L44)))*R44+(((L44*O44+L44)*PA4+(LA4*O44+L44))*Q44+((LA4*O44+L44)*PA4
+(L44*044+L44))))

Example for Programmable Funds view (this formula can be copied directly into the
Programmable Funds view):

=((((Z44*ACA4+Z44)*ADAA+(ZA4*ACAA+Z44))* AEA4+((ZA4*ACAA+Z44)*ADAA+(
ZA4*ACAA+Z44)))*AFA4+(((Z44*ACA4+ZA4)*ADAA+(ZA4*ACA4+ZA4))* AEA4+((Z
44*ACA4+Z44)*ADA4+(Z44*ACA4+Z44))))

Example for Budget Details Worksheet (this formula can be copied directly into the
Budget Details burdened rate column):
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=(((LA4*O44+LA4)*FA4+(LA4*O44+L44))*GAd+((LA4*O44+LAA) FA4+(LA4* 044+
L44)))*HA4+(((LA4*O44+LA4)* FA4+(LA4*O44+L44))*GA4+((LA4*O44+LA4)FAd+(
L44*044+L44))))

Burdened Rate for DAI Labor

Burdened Rate = pay rate * specific fringe and overhead

This formula is used in the DAI Labor section of the Pipeline Costs and Programmable
Funds views of the Expenditures Worksheet and in the Budget Details Worksheet.
This example is from the Budget Details Worksheet, but can also be copied into any
DAI Labor section of the Expenditures Worksheet:

=((B11*E11+B11)*F11+(B11*E11+B11))

Summary Calculations

=SUM(first cell reference number:last cell reference number)

This equation is used when you want to total a long horizontal or vertical row of
numerical figures which are uninterrupted by text. For example, if you wanted to add
the values in column C from row 13 to 21, you would likely enter the following equation
in cell C22:

=SUM(C13:C21)

IF, Then Statements

Used in the Activity Summary and Activity Budget Worksheets, an “If, Then” statement
is a conditional formulation. In FIPPS it is used to tell you whether an activity is over
budget. In the following equation, cell E22 contains the remaining funds for an activity.
If this amount is negative, the phrase “over budget” will appear in red type at the top of
the screen. If the remaining amount is positive, the phrase “positive budget” will appear
in the same place.

=IF(E22<0, “Overbudget”, “Positive Budget”)
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Conditional Statements

Conditional Statements are used to make certain changes occur in a cell or group of
cells once triggered by a certain event. Throughout FIPPS, conditional statements are
used to highlight indicators. For example, once a calculated value becomes negative, it
will turn red. When a “% remaining” value falls at or below 25% of budget, it will turn
blue to serve as a warning.

G&A and Fee

It is important to remember that FIPPS always calculates G&A before fee. If you are
unsure of a calculation FIPPS has made concerning either G&A or fee, reference the
formulas in their corresponding cells to make sure they are being properly calculated,
one before the other.
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